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Summary 
 

The present deliverable summarizes the outcomes of the third ATHENA workshop and 

provides all related material, both prior its accomplishment (e.g. agenda) and material such 

as presentations and list of participants. 

 

The third workshop was entitled: “Geo information systems (GIS)” and was organised by 

Verena Jaspersen from the DLR at the RSCy 2018 in Cyprus. The workshop was split into 

two parts. In the first part, Verena Jaspersen covered the fundamentals of GIS in form of a 

presentation. What is GIS? What is it used for? What are the main parts of a GIS? Which 

software can be used to set up a GIS? Furthermore, the participants got an insight into 

examples of web-based GIS that show-case how GIS can be used to disseminate data and 

information to a wide user group. The participants also learnt about Open Geospatial 

Consortium and their standards such as Web Mapping Service (WMS) and Catalogue 

Service for the Web (CSW) to make GIS work in a distributed world.  

 

The second part was a real Hands-On Workshop on working with. In this hands-on workshop 

the participants started to work with QGIS (https://www.qgis.org). After a general introduction 

to QGis and its plugin mechanism, we practically worked with what was covered during the 

presentation. 
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1. Introduction 

 

The 3nd Workshop of ATHENA has been succesfully accomplished in line to the timeline of 

the project. The Workshop was leaded by the DLR consortium member and hosted by CUT 

(Project coordinator) during the 'Sixth International Conference on Remote Sensing and 

Geoinformation of Environment' - RSCy2018 held on the 27 March 2018 in Paphos (Cyprus). 

The topics of the conference and workshop are correlated, thus the partners of ATHENA 

project decided to combine the two events, in order to attract more scientists interested in the 

subject. The workshop was free and open. This was an added value for the workshop, as 

well as for dissemination of the ATHENA project to the internaitonal scientific community and 

to local stakeholders. This was agreed by all ATHENA consortium members, after the last 

year's succesfull second annual meeting at CUT.  

The workshop entitled “Geo information systems (GIS)”, was a 2 hours and 30 minutes (refer 

to the agenda below - section 2 of the present document) that ended with Hands-On 

Workshop on working with GIS (refer to minutes of the workshop below - section 5 of the 

present document). 
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2. Agenda of the workshop 
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3. List of Participants 
 

Twenty-Four participants attended the Workshop coming from various European and 

international institutions, representing both the academia, industry and research centers. The 

majority of the participants were from the Cyprus University of Tecchnology.Supporters of the 

project such as the Department of Antiquties of Cyprus have also the opportunity to follow 

the specific workshop. 
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4. Minutes of the workshop 
 

" ATHENA Workshop on Geo information systems (GIS) ", Paphos, 
Cyprus, March 27th 2018 
 

First part: Presentation on the fundamentals, usages, software and standards iof GIS 

Verena Jaspersen (DLR) presented some fundamental concepts geographic information 

systems. GIS can be thought of as an umbrella under which we find hardware, software, 

methods, data, network and people. So GIS is not just software, or just data.  

 

We saw what space, distance and location can mean in a GIS. Furthermore, the difference 

between spatial data and attribute data was highlighted by some examples. Different ways of 

representing spatial phenomena were shown, and how they can be then assembled in GIS 

layers. 

 

GIS is applied in many different disciplines to solve many different problems. There are many 

free and open source, but also commercial GIS Desktop applications available to work with, 

but also a bunch of software to bring GIS to the world wide web. A common GIS web 

infrastructure was shown, and the problem described how to share spatial data within such a 

spatial data infrastructure. The need for standards was discussed. Here, the open geospatial 

consortium (OGC) plays a crucial role, so the consortium was introduced to the audience. 

The audience learned which standards are propagated by OGC and how the communication 

pattern roughly worked in OGC Web Services. The difference between ISO and OGC was 

shown as well. The WMS Standard was demonstrated in a live demo. Verena Jaspersen 

showed the underlying communication between a web site and a WMS Service to 

demonstrate the former described communication pattern.  

 

The Infrastructure for Spatial Information in the European Community (INSPIRE) plays a 

crucial role in the data exchange efforts within all EU countries, therefore the presentation 

also covered the main goals of this initiative. There is also an implementation of INSPIRE 

existing for cyprus.  

 

Last but not least, the topic of metadata was addressed in the presentation, why metadata 

about data is needed, and how this data can be encoded in XML in a standardized way. 

Verena Jaspersen demonstrated the use of metadata in the already finished project 

WISDOM (http://wisdom.eoc.dlr.de, on this project page you also find a link to the developed 

information system) and also showed the basic communication pattern between the client 

(the browser) and the OGC Catalogue service for the web.  
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Second part: Hands-on session  

 

In this hands-on session the participants learned how to work with QGIS. We used the 

version QGIS 2.18. The sessions was structured as follows:  

1.  download sentinel 2  scenes from sci hub 

2. load different layers to QGIS 

3. create new vector layers by digitizing 

4. merge and style vector layers 

5. use composer to desgin a map for printing 

 

1.) As sentinel imagery is free and with a quite good resolution, the participants were 

introduced to the Sentinel Science Hub (https://scihub.copernicus.eu). The participants could 

search data by applying different filters. Verena Jaspersen provided already downloaded 

sentinel 2 images and distributed them among the participants as the download would have 

taken too long during the session. 

 

2.) In QGIS there are different ways to load data to the  During the session, we have seen 

how to add a WMS Layer from a WMS Service (namely https://geoservice.dlr.de). 

Furthermore, the participants were introduced to the plugin management and should install 

the Open Layers Plugin. This plugin allows to use services such as bing, google maps and 

OSM. Then, the we loaded the sentinel 2 scenes (bands 4,3,2) to QGIS and built virtual 

layers so that the three bands can be visualized as one optical image. The different sentinel 

2 scenes needed to be merged and the color tables harmonized so that the scenes looked 

similar. 

 

3.) With the sentinel 2 images as a background, we started to create new vector layers by 

digitizing objects. The main idea was to create a land cover classification, so objects of 

interest were water bodies, agricultural fields, forests, etc. The participants learned how to 

use the digitizing tool set to create vector layers for each class with respect to the correct 

coordinate system. 

 

4.) The created vector layers of step 3. were then merged into one layer. We also used the 

QGIS styling capabilities to color the different classes in a nice and intuitive way. 

 

5.) In this part of the session, the participants should use the QGIS composer to create a 

nice looking, printable map, that provides information on the created land cover classification. 
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A title, abstract, legend information, north arrow, credit etc. should be placed on the map so 

that users of the map are well informed about the information they see.  

 

Step 5 could not be demonstrated anymore, as we ran out of time. But on the hand-out for 

this hands on session, detailed description is given, so that the participants can try to solve 

that later on. 
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5. Photos from the Workshop 
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ANNEX 
 

PRESENTATIONS OF THE WORKSHOP 

 
 
 

 

 



Geo Information Systems (GIS) 

DLR.de  •  Chart 1 

Fundamentals, Usage, Standards and Examples 
 
Verena Jaspersen 

 



Earth Observation Center (EOC) 
 
 German Remote Sensing Data Center (DFD)  
Director: Stefan Dech 
 
Remote Sensing Technology Institute (IMF)   
Director: Richard Bamler                 

 

~ 350 staff at EOC 

~40 staff at Universities  
(TU München, Univ. Würzburg, 
Augsburg) 

~ 250 scientists  

 
− ca. 53 % third party funding 

 

Berlin-Adlershof 

Oberpfaffenhofen 

München 

Würzburg 

Bremen 

Neustrelitz 

Augsburg 



System approach at EOC 

 
User Services 

 
World Data Center (WDC) 
Emergency Mapping (ZKI) 

Airborne Optical Remote Sensing 
(OPAIRS) 

German Satellite Data Archive  
(D-SDA) 

Maritime Safety and Security Lab 
 

Earth Observation Missions  
TerraSAR-X, TanDEM-X, Sentinel-1, Sentinel-3, Sentinel 5P, NOAA, Terra/Aqua, Landsat, FireBIRD, 

TanDEM-L, Enmap etc. 

Atmosphere 

Land Surface 

Geo Risks/ Security 

Water and Cryosphere 

Transportation / Energy 

 
Thematic Products 

Geo-Research 
Geo-Information Systems 

 

DFD 
 

 
Sensor Technologies 

Method Development 
Basic Processing 

 

IMF 
 

 
Payload Data Ground Segment 

IT- Development, Engineering, Operations 
 

DFD 



• Introduction to GIS 

• What is GIS 

• Thinking about Space, Location, Distance 

• Understanding Geospatial Data Models 

• GIS Applications and GIS Software  

• GIS and the Need for Standards 

• Open Geospatial Consortium and OGC Standards 

• INSPIRE: the European Initiative 

• Metadata: Data about Data 

 

 

 

Agenda     
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GIS is a computer based system to aid in the  
 

• Collection  
• Maintenance 
• Storage  
• Analysis 
• Output 
• Distribution  

 
of spatial and non spatial data 

What is GIS 

> GIS > Verena Jaspersen > March 2018 DLR.de  •  Chart 5 



> GIS > Verena Jaspersen > March 2018 DLR.de  •  Chart 6 

https://learn.canvas.net/courses/464/files/238860/preview?verifier=4Yg61PzlSQCTViw
simGQrRk4y4QdwPlN57fquJjk 



Absolute space 

Thinking about Space 
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https://onmaps.de/files/onmaps/news/TK25/tk25_20000.png https://www.u-bahn-muenchen.de/bild/sehrgross/ 
schnellbahn1972februar.jpg 

http://www.beruehrungspunkte.de/wp-
content/uploads/2011/05/Bildschirmfoto-
2015-02-24-um-14.15.12.png 

Topological space Cognitive space 



  
  
  

  

Thinking about Location 
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https://thumbs-prod.si-
cdn.com/0rQSHAWkucV1O0dmyJVN8Ml0sS4=/800x600/filters:no_upscal
e()/https://public-media.smithsonianmag.com/filer/5c/ea/5cea567c-050b-
432a-834f-fc94dcb1b49e/coordinates.jpg 

absolute location 

http://media-
cdn.sueddeutsche.de/image/sz.1.1108264/920x
613?cropRatios=0:0-BiGa-
www&cropRatios=3:2&cropRatios=2:3&method=
resize&v=1355628030 

http://www.eisbachwelle.de/wp-
content/uploads/2012/04/Flosslaende-Munchen-
Surfen-2012.jpg 

cognitive location 

9/11 
nominal location 

relative location 

South of Turkey 

North of Egypt 



Thinking about Distance 
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~460 km 

~6 h 

absolute distance 

relative distance 

cognitive distance 

Personal feeling 



• spatial data (where):     

       specific location 
 

• attribute data (what): 

specifies what is at that location 
stored in a database table 

Understanding Geospatial Data Models  
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Types of spatial phenomenon 
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http://www.williamsnd.com/usrfiles/dept/136/img/gis_layers.png 

https://www.e-education.psu.edu/geog486/sites/www.e-
education.psu.edu.geog486/files/image/L05_fig01.jpg 



Attributes 
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http://doc.arcgis.com/de/maps-for-sharepoint/arcgis-map-web-part/GUID-AF491B84-
B33B-4CFD-8929-88D4E53D2F45-web.png 

https://doc.arcgis.com/de/web-appbuilder/create-apps/GUID-62B44A73-C4E0-
41F7-9C03-A65B7BCD4667-web.png 



 

Storing descriptive Information 
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http://www.geog.ucsb.edu/~kclarke/G176B/robinson.jpg 



Types of Spatial Data Models 
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http://gsp.humboldt.edu/olm/Lessons/GIS/08%20Rasters/Images/convertingdatamodels2.png 

Vector Data Raster Data 

Formats 
• Digital Line 

Graphs (USGS) 
• GML 
• GeoJSON 
• Shapefile (Esri) 
• … 

 

Formats 
• Geo TIFF 
• IMG (Erdas 

Imagine 
• JPEG2000 
• netCDF-CF 
• … 

 



 

Application of GIS 
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http://www.esri.com/news/arcnews/fall07articles/fall07gifs/p3p2-lg.jpg 



GIS Desktop Software 
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gvSIG 

QGIS 

GRASS GIS 

SAGA GIS 

https://gisgeography.com/free-gis-software/ https://gisgeography.com/commercial-gis-software/ 

ArcGIS 

Geomedia 

MapInfo Professional 

AutoCAD 



GIS Software for the Web 

> GIS > Verena Jaspersen > March 2018 DLR.de  •  Chart 17 

INFRASTRUCTURE DESIGN FOR MAKING YOUR OWN WEB-GIS APPLICATION WITH OPEN SOURCE GEOINFORMATION TECHNOLOGY –  
Scientific Figure on ResearchGate. Available from: https://www.researchgate.net/Structure-of-Web-Mapping-Web-GIS_fig1_316788084 [accessed 23 Mar, 2018] 

? 



 

GIS: Need for Standards 
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GIS: Need for Standards 
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Arc 
Catalogue 

Oracle 

Postgres 

Exchange  
Standards 



 

GIS: Need for Standards 
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http://commons.esipfed.org/sites/default/files/skitched-20120424-161559.png 

Web Feature Service (WFS) 

WPS 

? 

Web Processing Service (WPS) 



Open Geospatial Consortium 
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• OGC is an international standardization organization 

• Definition of standards for geospatial content and services, 

GIS data processing and  data sharing 

• Using a standard like OGC, the interfaces are compatible 

 

 

http://www.opengeospatial.org/ 



Open Geospatial Consortium  
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OGC Membership Distribution 

OGC User Community 

• Requires collaboration on a global basis 
 

• Requires consensus by many organizations 
 

• Requires give and take 
 

• Requires repeatable processes 

Standards Development is not easy! 



• The OGC Standard development process is transparent and consensus 
oriented 

• Workflows are defined 

• Standards are freely available – ISO Standards need to be payed for 

• Agreements with ISO are arranged if possible and necessary to avoid conflicts 

• ISO Standards are more like laws 

 

Differences between ISO and OGC 
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https://www.spar3d.com/wp-
content/uploads/2014/12/OGC_LOGO_real.jpg 

http://tqtconsultant.com/wp-content/uploads/2016/08/ABOUT-
ISO.jpg 



 

OGC Web Services (OWS) 
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CSW – Catalogue Service for the Web 
WMS – Web Map Service 
WFS – Web Feature Service 
WCS – Web Coverage Service 
WPS – Web Processing Service 
 
 
SLD  – Styled Layer Descriptor  
GML – Geographic Markup Language 
Simple Features for SQL 
… 

http://www.eclipse.org/community/eclipse_newsletter/2014/march/images/article1
.1.png 
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Slide 26 

OGC Web Services: Communication Pattern 

HTTP Request: GetCapabilities 

What can 
you do? 

Client Server 

Here.. 
Read this! 

Capabilities Document 

<Service>  
  … 
</Service> 
<Capabilities> 
  … 
</Capabilities> 
<Layer> 
  … 
</Layer> 

Get Metadata, Map, Feature, or Coverage Great! Give 
me data  

Data 

Here 
you are! 

Copyright © 2010, Open Geospatial Consortium, Inc. 



• You can exchange data easily, as you provide interoperable services 
• You avoid redundant data management: this saves a lot of money! 
• You can easily access up to date datasets 
• You are independent from software vendors 

 
 All are speaking a “common language” 

 

Advantages of Using OGC Standards 
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• https://geoservice.dlr.de/ 
 
 

 
 

 
 

OGC Services: Demo WMS 
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https://geoservice.dlr.de/


• aims to create a European Union spatial data infrastructure for the 
purposes of EU environmental policies and policies or activities which may 
have an impact on the environment. 
 

• Focused on sharing of environmental spatial information among public sector 
organisations  semantic interoperable services 
 

• Based on the infrastructures established and operated by the Member States 
of the European Union 
 

• The Directive came into force on 15 May 2007 and will be implemented in 
various stages, with full implementation required by 2021. 

INSPIRE 
Infrastructure for Spatial Information  
in the European community 
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https://inspire.ec.europa.eu/ 



 

INSPIRE in your Country https://inspire.ec.europa.eu/INSPIRE-in-your-Country 
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Catalogue and structure data for better searching 
 
 Users can asses the suitability of a dataset for a particular application 

 
 

Need for Metadata: Data on Data 
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keyword 

Alice Card Catalogue Books 



 

Need for Metadata: Data on Data 
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Metadata provide answers to these questions! 
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Metadata & OGC Catalogue Service for the Web (CSW) 
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Geodata 

Catalogue  WMS / WFS / WCS 

Meta- 
data Meta- 

data Meta- 
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describe 

Search  
for Data 

XML 



 

Metadata & Catalogue Service for the Web (CSW) 
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ISO Standard 
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• ISO 19115, 19119 defines what information has to be given 
• Based on Content Standard for Digital Metadata of Federal Geografic 

Data Committee (FGDC), USA 
• Mandatory elements (they MUST be given) 
• Optional elements (they CAN be given) 
Definition of domain specific Profiles possible 

• ISO 19139 defines how the information can be encoded in XML 
 

Metadata: Important ISO Standards 
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Metadata: ISO Standard by Example  
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Metadata: Profiles for Different Disciplines 
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https://s3.amazonaws.com/libapps/accounts/3908/images/metadatastandards.png 



• http://wisdom.eoc.dlr.de/ 
 
 

 
 

 
 

Metadata: Demo CSW 
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GIS Architecture: Example 

> GIS > Verena Jaspersen > March 2018 DLR.de  •  Chart 41 



 

GIS Architecture: Distributed Processing with WPS 
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• What is GIS? 

• GIS Software 

• Standards to bring GIS towards a Geospatial Data Infrastructure (GDI) 

• OGC OWS 

• ISO and Metadata 

• GIS Architecture Examples 

 

Wrap Up 
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https://i2.wp.com/www.northrivergeographic.com/wp-content/uploads/2012/07/wordle.png?ssl=1 

Thanks for your attention! 
Any questions? 



Understanding Coordinate Systems and Map 
Projections 
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Datum 

North American Datum of 1927  
(NAD 27) 

North American Datum of 1983 
(NAD 83) 

World Geodetic System 1984 
(WGS 84) 



3-D Coordinate Systems 
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http://www.learner.org/jnorth/images/graphics/mclass/Lat_Long.gif 



coordinates 
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Degrees minutes secodns: 
 34°56‘09.8“N 32°51‘48.3“E 

Decimal Degrees: 
34.936044, 32.863425 

https://www.google.de/maps/place/34%C2%B056'09.8%22N+32%C2%B051'48.3%22E/@
34.9360457,32.8625934,303m/data=!3m2!1e3!4b1!4m14!1m7!3m6!1s0x14de1767ca494d
55:0x324c3c807fc4146e!2sZypern!3b1!8m2!3d35.126413!4d33.429859!3m5!1s0x0:0x0!7e
2!8m2!3d34.9360437!4d32.8634251?dcr=0 



 

2-D Coordinate system/ Cartesian Coordinate System 
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http://faculty.wlc.edu/buelow/PRC/grid2.gif 

https://upload.wikimedia.org/wikipedia/commons/thumb/2/2c/3D_coordinate
_system.svg/487px-3D_coordinate_system.svg.png 



• Universal Transverse Mercator Coordinate System (UTM) 
 

2-D Coordinate system/ Cartesian Coordinate System 
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https://upload.wikimedia.org/wikipedia/commons/e/ed/Utm-zones.jpg 

1-60 zones 

 A-X 

84° North 

80° South 



Map projections 
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Concept of map projection 

https://2012books.lardbucket.org/books/geographic-information-system-
basics/section_06/8c5c63aacfa3743ed4962745a77d782c.jpg 



Projection Properties 
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Major properties 

area and shape 

Minor properties 

distance and direction 

map distortion 

True directions 
True distances 
True areas 
True shapes 



Map Projections 
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http://www.quadibloc.com/maps/images/hammer.gif 

http://www.emapsworld.com/images/world-cylindrical-equal-area-
projection-map.gif 

Equal area projections 

Hammer-Aitoff projection 

Conformal map projection 
Mercator projection 

https://upload.wikimedia.org/wikipedia/commons/thum
b/f/f4/Mercator_projection_SW.jpg/350px-
Mercator_projection_SW.jpg 



Map projections 
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Equidistant map projections 

Equidistant cylindrical map projection 

http://geophysics.eas.gatech.edu/classes/Intro_GMT/gmt_www/gmt/
doc/html/GMT_Docs/img147.png 

Azimuthal map projection 

http://northstar-www.dartmouth.edu/doc/idl/html_6.2/images/maps06.gif 



 

Combining Map projections 
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http://www.spatialquerylab.com/FOSS4GAcademy/Lectures/GST101/L3/Understandin
g_Coordinate_Systems_and_Map_Projections%20output/story_html5.html 



 
 
 
 

 

 Basic Usage of QGIS Command, 
software  

1.  Get Data: https://scihub.copernicus.eu Open hub, 
sign 
up/login,  

2.  Search for data for Cyprus and download if needed (Data is rather big, so 
download takes some time 

 

 
 

Working With QGIS: Load Different Data To Map 

1.  Open QGIS 2.18.15 and start a new Project Project > Project 
Properties > check 
enable ‘on the fly’ 
CRS information 
coordinate 
reference system: 
WGS 84 / UTM zone 
36N (EPSG:32636) 

2.  Add WMS Layer from https://geoservice.dlr.de: 
 

Layer > Add Layer > 
Add WMS/WMTS 
Layer 
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https://geoservice.dlr.de/
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3.  

 
 

Give a name 
URL: 
https://geoservice.dl
r.de/eoc/basemap/w
ms 
 
click OK 

4.  

 
 

choose 1 basemap 
and click Add 

5.  Plugins allow you to extend the functionality QGIS offers: Use Well 
Known Services for your Map 

Plugins > Manage 
and Install Plugins > 
Open Layers Plugin, 
install plugin 

6.  Use Services such as Bing, Google, OSM Web > Open layers 
plugin: e.g. Google 
Maps 

 Load Sentinel Data into QGIS (layer panel)  

7.  Sentinel 2 Data comes in different bands.  
Visual bands are 4 (red), 3 (green), 2 (blue) 

Browser panel > 
browse the 
files,GRANULE, 
IMG_DATA,drag 
and drop of band 
2,3,4 

https://geoservice.dlr.de/eoc/basemap/wms
https://geoservice.dlr.de/eoc/basemap/wms
https://geoservice.dlr.de/eoc/basemap/wms
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8.  
 

Build virtual layer in QGIS to display all 3 bands in one Raster > 
Miscellanous > Build 
Virtual Raster 

 
      Check „separate“ 

Check the correct order of bands! 

9.  Do the same for two Sentinel 2 Datasets. Between the steps, switch 
off the layers you already created and the bands you don’t use. 

 

 

10.  Merge the two raster datasets (if you do it for all 5 datasets, it will 
take a lot of time) 

Raster > 
Miscellaneous > 
Merge 
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Working With QGIS: Create New Layers by Digitizing 

 Create a layer with two or three different land cover or land 
use categories 

 

11.  First: Create new shapefiles (for each category one) Layer > Create Layer 
> New Shapefile 
Layer 

12.  

 

> Polygon 
> WGS 84 / UTM 
zone 36N 
(EPSG:32636) 
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13.  New field: you can add many different attributes (name, area…)  

14.  Start editing the polygons Right click at the 
shp., toggle editing,  

15.  

 

Add feature 

16.  

 

Clip the polygon 

17.  When you finished the polygon: right click, the attributes appear 
(make sure that the id of each polygon of the same land cover/ land 
use category is the same) 

insert attributes  

18.  Stop editing Right click at the 
layer > save layer 
edits.  current edits, 
cancel for selected 
layer(s) 

19.  Merge shapefiles  Vector > Data 
Management Tools 
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use Version 2.18.15 (bug in version 2.18.14) > Merge Vector 
Layers 

20.    

21.  

 
 

Browse layers to 
merge, save file 

22.  update existing attributes or add new ones 

calculate the area with the field calculator  

Open attribute 
table, open field 
calculator 

23.  Field calculator Uncheck only 
update 1 selected 
feature, Check 
update existing 
field, row number 
(geometry), $area 

24.  

 
 

 

25.  Make sure that each category gets a different color Properties, style, 
categorized, 
column: id, classify 
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You can change each color/legend (double click) 

 

Working With QGIS: Design Your Own Map 

26.  Use Composer to design your own map Project > new print 
composer 

27.  composer for mapdesign; Your map from qgis desktop will be shown 
in the map frame; 
check the scale in the main properties in the item properties;  
you can add a second map frame which displays something different  
or an overview map (check the map in QGIS desktop) 

Layout > Add map 

28.  On the left side or layout: many different tools, e.g. scale bar, north 
arrow, legend,  
you can move your map or the map content: select/ move item or 
move item content;  

 

29.  Legend: in the legend items you can choose the items for your 
legend with + or -; you can change the font size of each group in the 
legend; spacing: change the space between the item groups  

Layout > Add 
Legend 

30.  Scale bar: make sure that the scale bar starts at 0, you can add a 
background color (white) 

Item properties, 
segments, left 0 

31.  Insert a grid (first you have to check the frame button; make sure 
CRS is the right one) 
Choose a grid type, the intervall, frame style, 
Draw cordinates, chosse format 

Grids +, 

32.  Insert an image; choose one of the existing images (arrow) or add a 
new one by searching directorie 

Layout > Add image 
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33.  Overview: Besides the main map, add a smaller Map that will be 
configured to be the overview map.  
 

Add Map > 
Overview +,  choose 
the main Map (map 
0) as map frame 

 

34.  Export 
 

Composer > Export 
as 

35.  More Information found here: 
 http://www.qgistutorials.com/en/docs/making_a_map.html 
 https://docs.qgis.org/2.18/en/docs/training_manual/map_com

poser/map_composer.html 

 

 

http://www.qgistutorials.com/en/docs/making_a_map.html
https://docs.qgis.org/2.18/en/docs/training_manual/map_composer/map_composer.html
https://docs.qgis.org/2.18/en/docs/training_manual/map_composer/map_composer.html
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